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Introduction
Ph
Welcome to the third generation of the PhotoGIF series, 

BoxTop Software’s sophisticated power tool for producing 

compact, high-quality GIF files for the Web. This is the user 

manual for the Macintosh version of PhotoGIF Filter™ 1.0, 

which works as an Adobe Photoshop filter plug-in instead of a 

file format or export plug-in. This way, it works with Photoshop 

2.5 or later and with most other programs that support 

Photoshop plug-ins. (Most programs that support Photoshop 

plug-ins only support filters, not other types of plug-ins.)

Other plug-ins in the PhotoGIF series include:

• PhotoGIF 3.0, a version of PhotoGIF which appears as an available file format in Save 
dialogs in Photoshop 3.0 or later and supports opening and saving animated GIFs 
(Macintosh/Windows)

• PhotoGIF Lite 1.0, a version of PhotoGIF which relies on Photoshop to do color 
reduction (the other plug-ins do their own color reduction for better results) and 
appears in Save dialogs (Macintosh/Windows)

• PhotoGIF Illustrator 1.0, a version of Photoshop which works with Adobe Illustrator 
6.0 or later (Macintosh only)

Demonstration versions of the latest version of these products can 
always be obtained from BoxTop Software on the Web at:

http://www.boxtopsoft.com/
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Installation
Ph
PhotoGIF is not a stand-alone program. Rather, it is a plug-in 
which works with Adobe Photoshop and other image editing 
programs. To install it, you must copy or move the PhotoGIF 
Filter icon to the folder where your image editing software 
expects to find filter plug-ins.

If you use Adobe Photoshop 3.0 or later

Open the folder containing the Photoshop application. In this window 
you’ll find a folder called Plug-ins. Open this folder and find the folder 
called Filters inside it. Drag the PhotoGIF Filter icon into the Filters 
folder.

Photoshop usually looks for plug-ins in the Plug-ins folder in the same 
folder as the application unless you tell it to look elsewhere. If you 
keep your Photoshop plug-ins in a different folder, put PhotoGIF Filter 
in the Filters folder inside that folder instead.

PhotoGIF will appear in the BoxTop Web Tools submenu of the Filter 
menu the next time you start Photoshop.

If you use Adobe Photoshop 2.5

Open the folder containing the Photoshop application. In this window 
you’ll find a folder called Plug-ins. Drag the PhotoGIF Filter icon to this 
folder.

Photoshop usually looks for plug-ins in the Plug-ins folder in the same 
folder as the application unless you tell it to look elsewhere. If you 
keep your Photoshop plug-ins in a different folder, put PhotoGIF Filter 
in the Filters folder inside that folder instead.

PhotoGIF will appear in the BoxTop Web Tools submenu of the Filter 
menu the next time you start Photoshop.

Adobe Photoshop

Plug-Ins

Filters

Adobe Photoshop

Plug-Ins
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If you use a different image editor

Most image editors have a folder called Plug-ins or Filters in the same 
folder as the application. Drag the PhotoGIF Filter icon to this folder. (If 
you can’t find the right folder, consult the instructions that came with 
your image editing software.)

Some image editors can be configured to look for plug-ins in a folder 
you choose, rather than in the usual folder in the same folder as the 
application. If you keep your plug-ins in a different folder from the one 
where your image editor normally looks for them, put PhotoGIF Filter 
in that folder instead.

The next time you start your image editing software, PhotoGIF Filter 
will appear in the same pull-down menu that lists your other filter 
plug-ins. (In most editors, this is the Filter or Plug-in menu. If you can’t 
find the right menu, consult the instructions that came with your 
image editor.) Depending on the software you use, it may appear in a 
submenu called BoxTop Web Tools, or mixed in with the other filters.

If you use more than one image editor

If you have more than one image editor, you may want to use 
PhotoGIF Filter with all of them. The most straightforward way to do 
this is to make two (or more) copies of the PhotoGIF Filter file, then 
put the copies in the Filters or Plug-Ins folder of the programs you 
want to use it with.

You may also be able to share a single copy of PhotoGIF Filter among 
multiple image editors by making an alias of the PhotoGIF Filter icon, 
then putting the alias in the Filters or Plug-ins folder of the 
applications you want to use it with. This way, when we release a new 
version of PhotoGIF Filter, you only need to update one copy. 
However, some image editors may not recognize aliases of plug-ins. If 
PhotoGIF Filter doesn’t appear in an image editor’s menus, try using a 
copy of the filter rather than an alias.

Image Editor Folder

Plug-Ins or Filters
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If you want to use all your filters in all the image editors you have, you 
may be able to achieve this by making an alias of your main Plug-ins 
or Filters folder, then replacing the Plug-ins and Filters folders of your 
other image editors with the alias. Alternately, if all your image editors 
can be told to look in a specific folder for plug-ins (check their 
Preferences dialogs), simply place all your plug-ins in a single folder 
and tell all your image editors to look for them there.
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Using PhotoGIF
PhotoGIF Filter is invoked like any other filter—by choosing it 
from the Filter or Plug-Ins menu of your image editor. In Adobe 
Photoshop, it appears under the BoxTop Web Tools submenu of 
the Filter menu. Instead of applying an effect to your image, 
however, PhotoGIF Filter exports the image (or the current 
selection) as a GIF file, much as an Export plug-in would. Your 
source image is never changed by using PhotoGIF Filter.

In this chapter you’ll learn:

• How to prepare your image for saving with PhotoGIF Filter

• How PhotoGIF’s color reduction dialog works

• How PhotoGIF’s image options dialog works

The next chapter provides step-by-step walkthroughs for a variety of 
common tasks you’ll perform with PhotoGIF.

Before You Save

PhotoGIF Filter works only with RGB images. If your image is in some 
other mode, such as CMYK or Indexed Color, convert it to RGB before 
choosing PhotoGIF Filter from the menu. In versions of Photoshop 
before 4.0, use the Mode menu. In Photoshop 4.0 and later, use the 
Mode submenu of the Image menu.

• Other image editors offer similar functionality but may use a different name, such as 
“Change Bit Depth” or “24-bit Color.” (See your image editor’s documentation if you 
can’t find this command.)

PhotoGIF Filter, like other filters, operates only on the active layer (the 
layer selected in Photoshop’s Layers palettes). If your image has more 
than one layer, you will need to reduce it to one layer before saving it 
with PhotoGIF Filter.
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Sh
Alp
In Photoshop, there are two primary ways to combine multiple layers 
into a single layer  suitable for saving with PhotoGIF Filter. (See your 
image editor’s documentation if you’re not using Photoshop.)

• Use the Copy Merged command on the Edit menu to copy all visible layers to the 
clipboard, then Paste to create a new layer. Use PhotoGIF Filter to export this layer as a 
GIF. You can delete the extra layer after you’ve saved.

• Save the document, then use the Flatten Image command on the Layer menu to 
reduce the image to a single layer. Use PhotoGIF Filter to export the image. After 
exporting, use the Revert command on the File menu to get your layers back.

If you are using an alpha channel to indicate what parts of the GIF 
should be transparent, make sure the alpha channel is selected (along 
with the image channels) by shift-clicking it in Photoshop’s Channels 
palette before saving. Because it’s a filter, PhotoGIF Filter knows only 
about the channels that are selected when you invoke it, so you must 
explicitly select the channel you wish to use for transparency. 
(Remember, in an alpha channel, black means fully transparent and 
white means fully opaque.)

Photoshop will not allow alpha and color channels to be selected at 
the same time if the document contains more than one layer, so you 
should flatten the image if you plan to use an alpha channel. If you’re 
not using Photoshop, consult your image editor’s documentation for 
information on selecting alpha channels.

You can have PhotoGIF export only part of a document by selecting  
the desired portion before invoking the filter. If no part of the image is 
selected, the entire image is saved.

ift-click the
ha channel
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Color Reduction

An RGB image can include about 16.7 million distinct colors. GIF, 
however, is an indexed color format which can store images with no 
more than 256 colors. PhotoGIF’s first order of business, then, is to 
choose the 256 (or fewer) colors that best approximate the colors 
actually used in your image. Since the number of colors is the main 
factor which determines file size of the final GIF file, it pays to use as 
few colors as possible. PhotoGIF has one of the most effective color 
reduction engines in the industry, with the result that it can obtain 
acceptable image quality with fewer colors than other tools—leading 
to the smallest GIF files possible. Best of all, PhotoGIF continuously 
displays the size of the GIF in its window, updating it whenever you 
make a change to the color reduction settings, so you can see exactly 
how the choices you make affect the size of the GIF file.
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Original and Indexed Previews: The color reduction dialog is 
dominated by two preview areas. The one on the left shows the 
original image; the one on the right shows the image after color 
reduction. The image on the right is re-generated whenever you 
change a color reduction setting.

When you move the pointer into either preview area, the arrow 
changes to a hand. Dragging with the hand scrolls the image preview. 
The two previews can be scrolled independently.

You can disable the display of either preview by unmarking the Show 
checkbox immediately below it.

Below the preview windows are file size indicators for both the 
original image and the compressed (indexed) GIF image. PhotoGIF 
automatically re-compresses the image using the settings you’ve 
chosen whenever you make a change, so the Indexed size is an 
accurate figure, not an estimate. (However, if part of your image will 
be transparent, the final file can be smaller. Transparent areas usually 
compress very well.)

Palette: This section of the color reduction dialog determines which 
colors will be used in the final GIF image. This assortment of colors, 
collectively, is known as a palette. The choices on the Palette pop-up 
menu include:

• Custom: PhotoGIF generates a custom palette based on the colors in the image. This 
usually gives the best results with photographic or continuous-tone images. This is 
similar to Photoshop’s Adaptive palette, although the algorithm PhotoGIF uses to 
choose the colors is different.

• Netscape: PhotoGIF uses the so-called “Netscape” or “Web Safe” palette, which 
consists of 216 colors that are available on all the platforms Netscape Navigator runs 
on. This allows you to see what your image will look like on a monitor which can only 
display 256 colors, and also ensures that line art which uses these 216 colors will never 
be dithered when displayed by a browser on a 256-color monitor.

• Grayscale: PhotoGIF converts the image to grayscale and selects an assortment of 
gray tones suitable for the converted image.

• System: PhotoGIF uses the Macintosh system palette.
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The Palette menu may also contain palettes which were loaded from 
other files using the Load button, which we’ll cover momentarily.

Below the Palette pop-up menu is the palette itself. This grid displays 
the collection of colors which will actually be used to color-reduce 
your image, whether calculated by PhotoGIF or loaded from disk. 
Clicking a palette square displays the color in the larger swatch to the 
right, along with its red, green, and blue color values. (Color values 
are displayed in decimal notation on a scale of 0 to 255.)

The Load button can be used to tell PhotoGIF to use the same palette 
as another image instead of generating a new one. An Open dialog 
appears, asking you to choose a GIF file or Photoshop palette file. The 
palette of the selected file appears at the top of the dialog, so you can 
preview palettes before you open them. (If the file you’ve selected 
contains more than one palette—as GIF files can—you can also 
choose which palette you want from the file using the arrow buttons.) 
At the bottom of the dialog, enter the name by which you want the 
palette to be known in the Palette pop-up menu in the main color 
reduction dialog.
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Depth and Colors: The Depth pop-up menu and the Color field are two 
different but related ways to specify the number of colors to be 
included in the color-reduced image. This is the single most important 
factor in the size of the final file.

The numbers on the Depth pop-up menu are related directly to the 
number of bits required by each pixel in the image; each additional bit 
allows a doubling of the number of colors.

Number of bits Number of colors
1 2 (B&W)

2 4

3 8

4 16

5 32

6 64

7 128

8 256

While the Depth pop-up menu lets you directly choose the number of 
colors that corresponds to each bit depth, you are not limited to these 
values. You can also enter the desired number of colors directly in the 
Colors field below the menu. The pop-up menu automatically changes 
to display the maximum number of colors which can be represented 
using the number of bits required for the number of colors you 
actually entered. For example, if you enter 10 in the Colors field, the 
pop-up menu changes to 16, since representing 10 colors requires 4 
bits per pixel (it won’t fit in 3 bits and you can’t use part of a bit), and 4 
bits per pixel can represent up to 16 colors.
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You may be tempted to try to make the color-reduced image look as 
much like the original as possible. But remember, the people who will 
see your final GIF files on a Web page don’t know what the original 
image looks like. The correct criterion for selecting the right color 
depth is whether it looks acceptable and loads quickly enough, not 
whether it is perfect when compared to its source material. The 
definition of “acceptable” depends on the type of image you’re 
compressing. An artist’s portfolio should naturally place more of an 
emphasis on accuracy than, for example, an 32-pixel-wide icon.

Sometimes it’s obvious what the “right” number of colors is. For 
example, if you have a two-color logo on a white background, the 
obvious starting point is three colors. If the logo is antialiased against 
the background, start with four times the number of non-background 
colors—8, in this case—and work your way up.

Sometimes, though, the image might be too complex for a simple rule 
of thumb like that one. Here’s a strategy that works rather well for 
choosing an appropriate number of colors when you’re not sure. 
(Eventually, after using PhotoGIF for a while, you will find yourself 
able to guess pretty accurately.)

• Turn off the Original image preview. Remember, the goal is not to match the original 
image but to produce acceptable results.

• Turn dithering (see below) all the way up to 10. Dithering has less of an effect on file 
size than the number of colors, so it is almost always better to have a file with fewer 
colors and high dithering than one with more colors and no dithering. We will adjust 
dithering later; for now it is best to focus on color depth, and setting dithering to 10 
eliminates it as a consideration.

• Set the number of colors to 2, then gradually increase the number of colors until image 
quality is acceptable for your purposes. Almost all images need more than two colors.

• Turn dithering off entirely by setting it to zero. If necessary, increase dithering strength 
gradually until image quality is acceptable again. You will almost never need to set 
dithering all the way back to 10.
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Dithering: Not every color in the original image can always be 
precisely represented in the GIF you save. It’s a mathematical 
impossibility, given that the source image can contain more than 
sixty-five thousand times more colors than a fully-loaded GIF. 
Therefore, PhotoGIF offers dithering, a process that approximates 
colors that are present in the original image that are not present in the 
palette. Dithering can be used to improve the visual quality of color-
reduced images, but it also results in larger files, since it introduces an 
element of randomness—also called entropy or noise—which cannot 
be compressed effectively.

Dithering can be used to combat an artifact common to color-reduced 
images called banding, in which what should be a smooth color 
gradient with no visible edges is broken into areas of flat, 
distinguishable colors. Increasing the color depth of the image can 
also reduce banding, but dithering is usually a better solution since it 
has less impact on file size. (Dithering can add a slight graininess to 
images, so in rare cases you may find more colors, and a larger file, 
preferable.)

Unlike Photoshop’s dithering, PhotoGIF’s dithering is adjustable. 
Some images, such as line art, won’t need much, if any. Others, such 
as photographs and 3D renderings, may require more dithering to 
eliminate visible banding.

Since dithering is less of a factor in file size than color depth, we 
suggest you start with dithering set at 10 and leave it there until you 
have found a color depth that provides acceptable image quality. Then 
turn dithering all the way down—which may reduce image quality 
noticeably—and increase it one notch at a time until image quality is 
once again acceptable. It should never actually be necessary to use a 
dithering of 10, since settings above 7 or 8 are usually visually 
indistinguishable but nonetheless reduce compressibility.
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Base: The Base pop-up menu protects specific colors, such as ones 
used in a logo or text, ensuring that they will appear correctly in the 
final GIF file even when they are not the predominant colors in the 
image. Before building a custom palette, PhotoGIF determines which 
of the colors in the base palette are present in the source image. The 
protected colors, if any are found, are copied to the custom palette, 
effectively reserving them a spot in the GIF. Then PhotoGIF chooses 
additional colors from the image and places them in the palette, up to 
the total number of colors you have specified.

In brief, then, the Base palette lets you guarantee that certain colors 
are never dithered when they are used in an image, without forcing 
the rest of the image to use the same palette. Colors from the base 
palette which aren’t actually used in the image do not take up space in 
your palette, leaving more room for colors which can make the rest of 
the image look good.

Before you can select a custom palette as the base palette, you must 
load it into PhotoGIF using the Load button next to the Palette pop-up 
menu. (The standard fixed palettes—the Netscape, Grayscale, and 
System palettes—are always available.) The Load button can read 
palettes from GIF files and Photoshop color palette files. (See page 11 
for more information on using the Load button.)

The Netscape palette, a collection of 216 colors which Netscape never 
dithers on a 256-color display regardless of the platform, is useful as a 
base palette if you have used colors from this palette in a line art 
image or illustration. Protecting these colors effectively ensures that 
areas where these colors have been used exclusively are never 
dithered by the browser on 256-color monitors, without subjecting the 
rest of the image to the same palette on monitors which can display 
more colors.

OK: Once you have chosen the desired color reduction settings, click 
OK to accept the color reduction settings and move on to setting the 
image options, including transparency.
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Image Options & Transparency

In this dialog, shown below, you can tell PhotoGIF which parts of the 
image should be transparent, set the desired background color, 
specify whether the image will be interlaced, and enter a comment for 
attachment to the final GIF file. You can also see the exact size of the 
image file in bytes. At the bottom of the dialog is the familiar palette 
display.

Transparency: The preview area in the Image Options dialog shows 
the effects of the transparency settings. At first, no transparency is set, 
so the image looks the same as it did in the Indexed preview window 
of the color reduction dialog. The Transparency tab at the top of the 
dialog determines method will be used for determining what part of 
the image will be transparent.
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PhotoGIF displays the effects of the transparency controls as you 
change them; the transparent areas are displayed using the 
background color set in the Background panel of this dialog. You 
won’t be able to see the transparent areas if this is the same as the 
canvas color. For example, if you created your image on a white 
background, and PhotoGIF’s background color is also set to white, you 
won’t be able to see the transparent areas as you work. Set the 
background color to a distinctive color so you can see the transparent 
areas. (However, you should set the background color to a more 
appropriate color before you save.)

• Alpha: The transparent portions of the image will be determined by an alpha channel, 
which you can choose from the small pop-up menu which appears next to the Alpha 
radio button when it is activated. (To allow PhotoGIF Filter to “see” the alpha channel, 
you must shift-click it in Photoshop’s Channels palette before invoking the filter. 
Photoshop will not allow you to do this if the image has more than one layer, so it will 
be necessary to flatten or merge multi-layer images first. See page 8.) Black areas in 
the alpha channel map to transparent areas in the image; white areas are opaque. GIF 
does not support partial transparency. Any non-black area in the alpha channel, even an 
extremely dark gray indicating a mostly transparent area, is treated as opaque.

• Color: All areas that are a particular color (or one of several colors) will be made 
transparent.

• None: The image is entirely opaque.

Background color: Clicking the Background tab displays the color 
which will be used to fill in the transparent areas of the image.
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The background color will often appear when the image is loaded into 
a GIF viewer or Web browser which doesn’t support transparency. In 
any case, it should match, as closely as possible, the color of the 
background over which the image will appear on your Web page, 
rather than the color of the background over which the image was 
created. (The two colors might of course be the same, but if they are 
different, use the Web page background.)

You can enter RGB color values using the sliders just under the color 
sample (the arrows at either end “nudge” the slider in the indicated 
direction), or by typing decimal or hexadecimal values directly into 
the fields to the right of the sliders. Or you can choose a pre-defined 
color directly from the pop-up menu above the sliders.

If you define a color using the sliders, the pop-up menu will also offer 
the option to add the new color to the pop-up menu. You’ll be asked to 
name the color; once you have done so, it will appear on the pop-up 
menu for quick access in the future. You can also remove a color from 
the pop-up menu using the Remove Color menu item.
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Transparency Tools: Once you have selected a method of defining 
transparency for your image and chosen the appropriate background 
color, you’ll want to define the actual transparent area. (If you are 
taking transparency from an alpha channel, the appropriate area 
should already be defined.) This is where the transparency tools, 
located under the image preview area, come into play.

• Paintbrush: Paints with transparency. Any part of the image you touch with this tool 
becomes transparent, regardless of its color. The paintbrush is useful for touching up 
stray pixels which are left over after you choose a transparent color with the 
eyedropper.

• Eyedropper: Chooses a transparent color. Every pixel in the image which is the same 
color as the pixel you click becomes transparent. Hold Shift while clicking to make 
additional colors transparent. Hold Command to make the color you click opaque, 
subtracting it from the existing transparency mask.

• Edger: Removes halos. It’s better not to have halos to begin with—you can reduce 
their occurrence by designing your image over a background similar to the one you use 
on your Web page—but if you have them, the Edger can help. Precision is not 
necessary; simply trace around the opaque area of your image, and the halo will be 
automatically removed. (This tool assumes an appropriate color has been set in the 
Background tab.)

• Hand: Scrolls the preview so you can work on other parts of your image.

• Zoom: Selects the magnification of the image preview, from 1:8 (one-eighth actual 
size) to 8:1 (eight times actual size). Click + to zoom in, - to zoom out.

Comments: You can enter up to 32 kilobytes of text under the 
Comments tab. Although you won’t often go to this extreme, it’s often 
worth a few bytes to enter a copyright or authorship notice.

Interlace: Interlaced GIF images have the rows out of order: first every 
eighth row, then every fourth, and so on. Since this out-of-order 
image data is displayed as it is received, interlaced GIFs appear to 
start loading faster in a Web browser, displaying a low-resolution 
version almost immediately and refining it further as more data 
arrives.

Paintbrush

Eyedropper

Edger

Hand
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Interlacing is recommended for large single-frame images. Users will 
be able to get a sense of what the image represents quickly, making 
the browsing experience smoother and apparently faster. (However, 
interlaced GIF files are not actually any smaller than normal ones and 
do not really load completely any faster.) Images smaller than a 
kilobyte or so should never be interlaced, as the time the browser 
spends rendering them will negate any advantage they offer.

OK. Once you’ve set your transparency and other options, click OK to 
save the image using a standard Save dialog. PhotoGIF Filter does not 
save previews or custom icons with the files it creates; therefore, the 
file size you see in the Finder is the image’s true size.
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Step-By-Step
The previous chapter described PhotoGIF Filter’s features and 
explained the dialogs and controls which operate these 
functions. In this chapter, we’ll walk through four kinds of jobs 
you’ll frequently find yourself doing with PhotoGIF Filter.

• Saving a photograph or computer-generated illustration

• Saving a line art illustration, using color to determine transparency, and removing a halo

• Saving a photograph, using an alpha channel to determine transparency

• Saving a mixed photograph and logo image, using a base palette to protect the logo 
colors

Saving a Photograph or Computer-Generated Illustration

Photographs, and computer-generated illustrations like the one 
shown below, frequently incorporate areas of gradients and shading 
which take full advantage of the millions of colors available on 
modern computer displays.

In a limited-color format like GIF, retaining acceptable image quality 
will require a relatively high number of colors and, more than likely, a 
fair amount of dithering. PhotoGIF helps you get the best possible 
results. Here’s how.
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• Our image is one layer deep, so we don’t 
have to worry about flattening it before 
we invoke PhotoGIF Filter. If we had 
used multiple layers, though, we’d have 
to flatten the image, or else create a new 
layer to paste a merged version of the 
image into.

• Now we open PhotoGIF Filter by 
choosing it from the Filters menu. The 
color reduction dialog appears.

• Since the image is larger than the 
preview area , we position the most 
important area of the image in the 
Indexed preview, so that we can see 
how our choices affect it.

• We set dithering to 10 to completely eliminate it as a factor for image quality. 

• We set the palette to Custom, so PhotoGIF generates a palette for us based on the 
number of colors in the image.

• We set the base to None, since we don’t want to protect any colors in this image from 
dithering.

• We turn off the Original preview so we’re not tempted to judge the color-reduced 
image against it. Our goal is to produce acceptable results rather than to match the 
original image precisely.

• We set the depth at 32 colors, which we intuit will not be enough.

• The image has lost a lot of its 
color and vitality due to the 
limited palette. We increase the 
depth to 64. That’s pretty good, 
but not perfect. We try 128. It 
looks great, which tells us that 
we probably don’t need quite that 
many colors. Using the Colors 
field, we determine that about 
100 will do.

• Next, we set Dithering to 0, 
completely turning it off. Not 
surprisingly, the image now 
contains visible banding in the 
sky.

• We increase dithering until the 
banding is not so objectionable. 
We found acceptable results at a setting of about 6.

• We make sure that the entire image has acceptable quality by dragging it around in the 
preview with the hand tool, just in case there are some areas where banding is worse 
than we expect. We find no surprises, so we click OK.

Initial settings for color reduction

Final settings for color reduction
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• This takes us to the Image Options 
dialog. This image has no transparent 
areas. However, we do want to enter a 
copyright notice in the Comments panel.

• After entering the comments, we click 
OK, then name the file in the Save dialog 
which appears.

Saving a Line Art Illustration with
Color Transparency and Halo Removal

We’ve scanned the three-color logo below from a company’s 
letterhead for use on their Web site.

Unfortunately, the letterhead is on white paper, while the Web site has 
a medium yellow background. We’ll use transparency to knock out the 
white areas, but the disparity in background colors will cause a white 
halo when the image is used on the Web site—so we’ll use PhotoGIF’s 
Edger tool to eliminate it.

• Our image is only one layer deep, so once again we can start simply by choosing 
PhotoGIF Filter from the Filter menu.

• Since this is a line art image, we turn dithering off entirely.

• We choose a Custom palette to allow PhotoGIF to generate the palette for us based on 
the colors in the image, with no Base.

Entering a copyright notice
otoGIF Filter 23



Ph
• The image contains four colors (including 
the white background color), so we try 
telling PhotoGIF to generate a palette 
with four colors. However, PhotoGIF 
reserves one space in the palette for 
black even if it’s not used in the image 
(for dithering purposes). Furthermore, 
since the image was scanned and 
reduced, it’s antialiased, meaning that it 
contains several in-between colors 
which serve to smooth out the edges of 
the image. Thus, the total number of 
colors needs to be higher to make sure 
the edges of the shapes in the logo are 
smooth.

• We find that sixteen colors is the lowest number of colors that produces acceptable 
results. We click OK. (We might be able to get by with fewer colors if we added 
dithering, but dithering is not appropriate for antialiased line art.)

• PhotoGIF displays the Image Options 
dialog. Under the Transparency tab we 
select Color, then click the white 
background of the image with the 
eydropper tool.

• We click the Background tab and set the 
background color to the yellow color 
we’re using for the background on the 
Web site.

• We zoom in the preview and see that we 
have a slight halo around the logo, so we 
grab the Edger tool and run it around the 
edge of the logo to eliminate the halo.

• When it’s gone, we click OK and save the 
image.

Color reduction settings for logo

Removing a halo with the Edger
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The
Saving a Photograph with Alpha Channel Transparency

Here we have a black-and-white photograph which we want to use on 
a Web page. We’ve created an alpha channel for just the person in the 
picture (and his video camera), which we’ll use to define the 
transparency and exclude the background from the Web page.

We have used an Adobe Photoshop adjustment layer on this image, 
so we’ll need to flatten it before proceeding.

• First, we save the image as a Photoshop file so we can later recover our file with its 
separate layers, then we choose Flatten Image from the Layers menu. This is 
necessary so we can select the alpha channel later.

• Change the image’s mode to RGB by choosing it from the Mode menu or from the 
Mode submenu of the Image menu.

• Open Photoshop’s Channels palette and shift-click the alpha channel in the palette. All 
three color channels, the RGB pseudo-channel, and the alpha channel should be 
selected and the alpha channel should appear as a colored mask over the image.

• Open PhotoGIF by choosing it from the Filter menu. The Color Reduction dialog 
appears.

 alpha channel
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• We find that a custom palette with 25 
colors, no base palette, and moderate 
dithering is sufficient for this image, and 
cilck OK. The Image Options dialog 
appears.

• In the Transparency panel, we choose to 
set the transparency from the alpha 
channel. In the Background panel, we 
choose a black background—the same 
color the image will appear over on the 
Web page.

• Luckily, the subject was photographed 
against a mostly dark background, so 
there is very little halo. What there is, we 
touch up with the Edger tool.

• This image is fairly large, so we make sure interlacing is enabled so it will appear to 
load faster.

• Finally, we click OK and then save the image using the Save dialog.

Saving a Mixed Image with a Base Palette for Color Protection

The image below contains both a continuous-tone image (a 
photograph) and a solid-color illustration (a logo).

Alpha transparency, black background
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The illustration uses colors from the Netscape (“Web safe”) palette 
which are similar to the colors in the photograph, which leads to the 
danger that PhotoGIF might end up dithering the logo, or altering the 
logo colors so that they are no longer in the Web safe palette and thus 
are dithered on computers displaying 256 colors. We will use a Base 
palette containing the colors in the logo to protect the logo from 
dithering by PhotoGIF and the browser. Here’s how.

• Create a new Photoshop document 
containing swatches of each of the 
colors from the logo. There is no need to 
be exact; you are simply creating a 
document which you will use to create a 
palette containing those exact colors. 
The easiest way to do this is to simply 
copy the logo portion of the image into a 
new document.

• Save this image using PhotoGIF Filter 
with no dithering and a custom palette 
consisting of 5 colors (the Indexed 
preview window shows us this is the 
right number to include all the logo 
colors). The resulting GIF will contain a 
suitable base palette. Since we only care about the palette, not any of the actual image 
data, you can ignore the rest of the options in PhotoGIF Filter and simply save the GIF. 
Once this has been accomplished, you can close the image.

• Bring the combined image to the front. We put the logo on a layer separate from the 
photograph to make compositing easier. Thus, we’ll need to combine these two layers 
into a single layer before using PhotoGIF Filter on them. (Remember, PhotoGIF, like all 
filters, only “sees” the active layer when it’s invoked.) In our example, since we won’t 
be using an alpha channel to set transparency, we’ll do this by selecting the entire 
image, choosing Copy Merged from the Edit 
menu, and then pasting the merge image, creating 
a new layer for PhotoGIF to save.

• Now we invoke PhotoGIF Filter by choosing it 
from the Filter menu. The Color Reduction dialog 
appears.

• We want to use the color palette we created 
earlier to protect the colors in our logo. To do so, 
we must first load the palette into PhotoGIF. Click 
the Load button above the palette. In the standard 
Open dialog which appears, locate the GIF file 
containing the logo palette and specify the name 
Logo Colors for the palette, then click Open.

Creating a GIF with just the logo colors
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• Choose Logo Colors from the Base pop-
up menu. The logo colors are now 
protected; PhotoGIF will not dither them. 
Since the colors are from the Netscape 
“Web safe” palette, the browser will not 
dither the colors either.

• Generate a custom color palette for the 
image using the usual techniques. We 
found about 170 colors and dithering of 
about 7 to be adequate. Click OK to 
move on the Image Options dialog.

• The image has a white background, and 
so does the Web page we’re placing it 
over, so it would be of no benefit to 
make the background transparent. Set 
interlacing as desired, add a comment if you like, and we’re done.

Color reduction settings for photo/logo image
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Support
E-mail questions about PhotoGIF Filter™ and other BoxTop 
Software tools may be addressed to info@boxtopsoft.com

BoxTop Software, Inc.
101 N. Lafeyette Street
Starkville, MS 39759

601-324-1800 (voice)
601-324-7352 (fax)

http://www.boxtopsoft.com

info@boxtopsoft.com
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License
End-User Software Evaluation License Agreement

Use of this software, PhotoGIF Filter™, constitutes agreement to the following terms 
and conditions, which constitute a legal and binding contract between you, the user, 
and BoxTop Software, Inc., the owner of PhotoGIF Filter.

The software, PhotoGIF Filter, is protected by copyright law and international 
copyright treaties, as well as other intellectual property laws. The software, 
PhotoGIF Filter, is licensed, not sold.

BoxTop Software, Inc. grants you, the user, a non-exclusive single user evaluation 
license to use this software, PhotoGIF Filter, for the purpose of evaluation for 
consideration of purchase. No other uses are permitted before the software, 
PhotoGIF Filter, has been purchased and a full license of the software, PhotoGIF 
Filter, is granted.

The software, PhotoGIF Filter, is distributed in limited function form for evaluation 
purposes. PhotoGIF Filter, may be evaluated for a period of no more than 90 days 
provided all terms and conditions of this agreement are met. After 90 days you must 
destroy all copies of the software, PhotoGIF Filter, in your possession if you have not 
purchased full license to continue use of the software.

You, the user, may not commercially distribute, sub-license, resell, or otherwise 
transfer for any consideration, or reproduce for any such purposes, this software, 
PhotoGIF Filter, or any modification or derivation thereof, either alone or in 
conjunction with any other product or program without prior written consent of 
BoxTop Software, Inc. Further, you, the user may not modify this software, other 
than for your own internal business use.

However, this software, PhotoGIF Filter, may be freely distributed in its original 
unmodified limited function form so long as this notice and all other documentation 
is included without alteration or modification of any kind.

BoxTop Software, Inc. specifically grants permission for this software, PhotoGIF 
Filter, to be made available in its original, unmodified limited demonstration form 
with all accompanying documentation at FTP sites, both public and private; on CD-
ROMs or disks included with published books or magazines at no additional charge; 
by commercial on-line services, which may charge a fee for download time as per 
their standard terms of service; from person to person; and by all other means of 
distribution that are not for commercial or personal profit.

If you would like to distribute this software, PhotoGIF Filter, by any means not 
specifically outlined above or license it to be bundled in registered form with other 
products please contact BoxTop Software, Inc. to arrange terms and conditions.

Without prejudice to any other rights, BoxTop Software, Inc. may terminate this 
license if you fail to comply with the terms and conditions of this license. In such 
event you must immediately destroy all copies of the software, PhotoGIF Filter, and 
all of its component parts in your possession.
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This software, PhotoGIF Filter, is the valuable intellectual property of BoxTop 
Software, Inc.. You, the user, may not reverse engineer, decompile, or disassemble 
the software, PhotoGIF Filter, except to the extent that such activity is expressly 
permitted by applicable laws not withstanding this limitation.

The software, PhotoGIF Filter, is provided with restricted rights. Use, duplication, or 
disclosure by the Government is subject to the restrictions as set forth in the Rights 
in Technical Data and Computer Software clause at DFARS 252.227-7013 or the 
Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19, as 
applicable. Manufacturer is: BoxTop Software, Inc. P.O. Box 2347, Starkville, MS 
39760 US.

If you acquired this software, PhotoGIF Filter, in the United States, this license is 
governed by the laws of the State of Mississippi. If you acquired this software, 
PhotoGIF Filter, in another country, this license is governed by the laws of the 
jurisdiction in which the software, PhotoGIF Filter, was acquired. For the purpose of 
electronic distribution over the Internet and other public on-line services the 
software, PhotoGIF Filter, will be considered to be acquired at the location of the 
originating file server. 

This software, PhotoGIF Filter, is provided to the user "AS IS." BoxTop Software, Inc. 
makes no warranties, either expressed or implied with respect to the software, 
PhotoGIF Filter,  and/or associated materials supplied to the user, including but not 
limited to any merchantability, fitness for a particular purpose or against 
infringement. BoxTop Software, Inc. does not warrant that the functions contained 
in the software will meet your requirements, or that the operation of the software 
will be uninterrupted or error-free, or that defects in the software will be corrected. 
Furthermore, BoxTop Software, Inc. does not warrant or make any representations 
regarding the use or the result of the use of this software or any associated 
documentation in terms of their correctness, accuracy, reliability, or otherwise. No 
oral or written information or advice given by BoxTop software, Inc. or BoxTop 
Software, Inc. authorized representatives shall create a warranty or in any way 
increase the scope of this warranty.

BoxTop Software, Inc. is not liable for any claims or damages whatsoever, including 
property damage, personal injury, intellectual property infringement, loss of profits, 
or interruption of business, or for any special or consequential or incidental 
damages, however caused, whether arising out of breach of warranty, contract, tort 
(including negligence), strict liability, or otherwise.
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